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Document Components 
 

Cover Page 
 

The final following table outlines the components of the first page, the Cover Page.   

Table 1: Components of Cover Page  
Component  Rule  
OCA Logo  Left aligned, appearing above the title   
Title   Left aligned, font size 54, bolded, OCA Blue, Hex# #008FBE. (Note that this 

may change if a different color theme is developed as discussed in 
Formatting, page 11) 

Footer  Left aligned, font size 11, white, background should be Turquoise Accent 1 
25% Darker, Hex# 006B8E and include the date published, the name of 
the Child Advocate and the link to the report  
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Table of Contents  
 
Each report should include a standard table of contents that appears after the Cover Page and 
before the Cover Letter and should be hyperlinked to the section headers. The Table of 
Contents should include Heading 1 and Heading 2 levels of information, but does not need to 
include levels below that (e.g. Heading 3.) The Table of Contents should be “updated” before 
sharing documents. For more information on how to insert, link and update a table of contents, 
click here.    
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https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-1d8552ccf0c0
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Cover Letter   
 

 

 

 

DATE  

The Cover Letter should appear on the official letter head of the Child Advocate. The graphic at 
the top of the letter head should be the width of the page, roughly 6.51 inches.  The date of 
publication should be listed before the start of the letter.  

 

Sincerely,  

 

 

 

 

Maria Mossaides 

Director, Office of the Child Advocate
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OCA Staff List    
 
All current OCA staff, and their titles should be listed as follows: 

Maria Z. Mossaides 
Director 

“The Child Advocate” 
 

Christine Palladino-Downs 
Senior Director of Quality Assurance 
 

Cristine Goldman 
Director of Policy and Legal Counsel 

Ari Fertig  
Legislative and Communications Director 
 

Melissa Threadgill 
Director of Strategic Innovation 

Bekah Thomas  
Senior Policy Manager  
 

Dana Deshiro 
Quality Assurance Supervisor 
 

Renee Franzis 
Quality Assurance Supervisor 
 

Kristi Polizzano 
Juvenile Justice Program Manager 
 

Tina Saadallah 
Clinical Specialist 
 

Alix Rivière 
Research and Policy Analyst 

Nicole Thornhill 
Clinical Specialist 

Jessica Seabrook 
Policy and Research Analyst 
 

Karen Blake-Robinson  
Clinical Specialist 
  
 

Morgan Byrnes 
Research and Project Coordinator 
 
Jean Clements 
Office Manager 

  
  

 
               
The OCA Staff List should be confirmed and, if necessary, updated prior to sharing and 
publishing. For OCA Annual Reports, the list should include only staff members employed 
during the fiscal year the annual report covers.  
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About the Office of the Child Advocate 
 
The following blurb should be provided in an “About the Office of the Child Advocate” section:  
The Office of the Child Advocate (OCA) is an independent executive branch agency with 
oversight and ombudsperson responsibilities, established by the Massachusetts Legislature in 
2008. The OCA’s mission is to ensure that children receive appropriate, timely and quality state 
services, with a particular focus on ensuring that the Commonwealth’s most vulnerable and at-
risk children have the opportunity to thrive. Through collaboration with public and private 
stakeholders, the OCA identifies gaps in state services and recommends improvements in 
policy, practice, regulation, and/or law. The OCA also serves as a resource for families who are 
receiving, or are eligible to receive, services from the Commonwealth.  

https://www.mass.gov/orgs/office-of-the-child-advocate
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Table of Acronyms  
 
Each report containing acronyms should include a table providing the relevant definitions. The 
table should have two columns, one titled “Acronym” and the other titled “Definition.” 
Formatting for the table is as follows: 

• Title: Calibri, size 14, font color white, background color OCA blue (Hex #008FBE) 
• Acronyms and Definitions: Calibri, size 12, font color black, background color white   
• Acronyms should be bolded  
• Rows: Borders around each row, border color OCA blue (Hex #008FBE) 
• Columns: No borders dividing the columns  
• Table should be the width of the page, 6.51 inches  

 
Acronym Definition  
BSAS Bureau of Substance Addiction Services  
CAFL Children and Family Law (Division of CPCS) 
CBHI Children’s Behavioral Health Initiative  
CBI Community-based intervention  
CPCS Committee for Public Counsel Services (Public Defenders) 
CTTF Childhood Trauma Task Force 
CWOF Continue Without a Finding 
DCF Department of Children and Families 
DESE Department of Elementary and Secondary Education 
DMH Department of Mental Health 
DPH Department of Public Health 
DYS Department of Youth Services 
EOE Executive Office of Education 
EOHHS Executive Office of Health & Human Services 
EOPSS Executive Office of Public Safety & Security 
JJPAD Juvenile Justice Policy and Data Board 
JDAI Juvenile Detention Alternatives Initiative 
MOU Memorandum of Understanding 
MPS Massachusetts Probation Service 
ONA Overnight Arrest  
SRO School Resource Officer 
YAD Youth Advocacy Division (Division of CPCS) 
YO Youthful Offender 
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Appendices1    
 
An appendix should be created on its own individual page labelled “Appendix” and followed by 
a title on the next line that describes the subject of the appendix. The title of each appendix 
should be written in Title Case and labeled as a Style Heading 1 (see Style Heading Section of 
this document below) so that it appears on the document’s Table of Contents. If there are 
multiple appendices, each should be labelled with a capital letter and referenced via footnote 
by its specific title (for example, “see Appendix A”). Appendices should be labeled A to Z.  
 

  

 
1 See Appendix A for example.  
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Contact Page  
 
The following table outlines the components of the final page, the Contact Page.   

Table 2: Components of Contact Page  
Component  Rule  
Office Title Calibri, font size 22, bolded   
Phone  Calibri, font size 14, header bolded 
Address  Calibri, font size 14, header bolded  
Website Link   Calibri, font size 14, header bolded, link in standard hyperlink blue (HEX # 

0000EE).   
Contact person   Calibri, font size 14, header bolded and should include the person’s name, 

title, and email address on policy reports that have a specific staff 
member as a contact.  
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Commonwealth of Massachusetts 

Office of the Child Advocate 
 

 
 

Phone 
Main Office: (617) 979-8374 

Complaint Line:  (617) 979-8360 
 

 
Address 

One Ashburton Place, 11th Floor 
Boston, MA 02108 

 

Website 

https://www.mass.gov/orgs/office-of-the-child-advocate  
 

Contact 

Name, Position 
Email 

 
 

tel:+16179798374
tel:+16179798360
https://www.mass.gov/orgs/office-of-the-child-advocate
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Formatting    
 

General    
 
The following table outlines the general formatting guidelines that should be applied 
throughout the document.  

Table 3: General Formatting Guidelines  
Component  Rule  
Font* Calibri2  
Font Size* 12  
Font Color*  All non-heading text should be black  
Alignment  Left  
Spacing  1.0 spacing between sentences, single space between words and after 

periods 
Margins  1” all around, 0.5 headings  
Header Should include the title of the report, left-aligned, and starting on the 

page after the TOC in the same font and font size as the body and the 
OCA logo, right-aligned. To learn more about inserting a header, click 
here.  

Page Numbers  Footer, right aligned, and starting on the page after the TOC in the same 
Font and Font Size as the body 

Theme  OCA Theme  
For specific report types, including reports that are the product of a 
Commission or Working Group, staff may also develop themes building 
off the OCA Theme. Learn more about creating custom theme here, and 
more about sharing a custom theme here. If a report uses a different 
color theme, notes on colors for specific items throughout this report may 
not apply.  

Page Breaks Insert Page Break between sections 
Numbers Spell out numbers less than 10 and/or a number that starts a sentence, 

heading, or title 
Bulleting  • Primary bullets should use the black circle symbol with an indent 

of 0.25  
o Secondary bullets should use the outlined circle symbol with 

an indent of 0.25 
 
There should be only a single space between bullets. Spacing of bullet and 
sub-bullet indent should be consistent across the document 

 
2 Calibri was selected from a list of accessible fonts recommend by Microsoft. To learn more about document accessibility, click 
here.  

https://support.microsoft.com/en-us/office/insert-a-header-or-footer-b87ee4df-abc1-41f8-995b-b39f6d99c7ed
https://support.microsoft.com/en-us/office/create-your-own-theme-in-powerpoint-83e68627-2c17-454a-9fd8-62deb81951a6
https://wordribbon.tips.net/T013089_Making_a_Customized_Theme_Available_to_Others.html
https://support.microsoft.com/en-us/office/make-your-word-documents-accessible-to-people-with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d#bkmk_best_practices_win
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Paragraph There should be a 1.08 space between paragraphs. Paragraphs should not 
be indented. Learn more about changing space between paragraphs here.  

Hyperlinks  Hyperlinks appearing both in text and in citations should be in the 
standard hyperlink blue (HEX # 0000EE).  

*Note: when copying content from other sources, often times the text formatting (color, font 
and text size) gets copied as well. Some of this formatting is easy to spot, while other 
components are not. Always go through and make sure non-heading text is Calibri, size 12 and 
black.  

OCA Theme  
 
All OCA publications should use the official OCA Microsoft theme that utilizes the colors from 
the OCA logo. The theme is available as a .thmx file in the OCA General channel on Teams here 
(note, the .thmx file will look like a blank PowerPoint template). More information on .thmx 
files can be found here.  
The theme should be downloaded locally. Once downloaded, the theme should be available by 
clicking the Design tab and then, on the left side of the ribbon, clicking the Themes tool. If the 
Theme does not appear in the “Custom” section, click the Browse for Themes option. In the 
resulting dialog box, you can navigate to the location where you placed the .thmx file, click that 
file, and then click Open. The theme should now be available within Word.  

Table 4: OCA Color Guide  
Color  Hex #  
OCA Blue  008FBE 
OCA Purple  800080 
OCA Red  EB0029 

 

Style Headings  
 
All sections and subsections of the report should be noted by adding a “heading style.” Heading 
styles can be found on the “Home” tab of Word. This makes the document more accessible 
while also making it possible to insert a standard TOC. For more information on style headings, 
please click here. Headings should follow the following guidelines: 

• All Headings should be in Calibri (Body). 
• There should be an extra space between Heading 1 and the content that follows. 

Heading 1 should be size 18.  
• There should be an extra space between Headings 2+ and the content that follows. 

Heading 2 should be size 14. However, in some reports that have a lot of graphs and 
small sections, it may be better to omit the extra space after Headings 2+. It is important 
that whichever option is chosen for a report (space between all headings and omitting 
the space for Headings 2+) that it is consistent across the entire report.  

https://support.microsoft.com/en-us/office/change-spacing-between-paragraphs-ee4c7016-7cb8-405e-90a1-6601e657f3ce
https://massgov.sharepoint.com/:u:/r/sites/OCA-TEAMS-AllStaff/Shared%20Documents/General/OCA%20Colors.thmx?csf=1&web=1&e=EaBtcF
https://answers.microsoft.com/en-us/msoffice/forum/all/how-do-i-share-a-customized-theme-colors-with-my/917a4d31-a03c-414c-a995-a5ac9af32004
https://support.microsoft.com/en-us/office/video-improve-accessibility-with-heading-styles-68f1eeff-6113-410f-8313-b5d382cc3be1#:%7E:text=To%20add%20a%20heading%20style,as%20the%20Heading%201%20button.
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• Headings should be written in Title Case (all words capitalized except for minor words 
unless they are the first or last word of the title). 

• Headings should use the OCA color palette   
 

Page Breaks  
 
Page breaks should be manually inserted after all major sections of reports. Section breaks 
should not be used.  To learn more about how to insert a page break, please click here.  

Graphs  
 
The following table outlines the formatting guidelines for all graphs included in the document. 
All graphs should be done in Excel and “copied and pasted” into the document.  

Table 5: Graph Formatting Guidelines  
Component  Rule  
Data  As a general guideline, data can be presented in either number or percent 

form, depending on what information and/or analysis is being 
communicated. Additionally, when appropriate, the n can be added to 
categories. Most importantly, all raw data included in any analysis 
should be provided in an appendix.  

Title Should include the figure number, be bolded, with the italicized title 
below, font size 12, black  

Caption Font size 10, include source, figure captions should not be italicized. 
Formatting  No outlines or grid lines, height 3.03, width 6.51  
Variables  Use labels for less than two variables, font size 10, black  
Axis Labels  Font size 11, written in Title Case (all words capitalized except for minor 

words unless they are the first or last word of the title), black  
Tables  Include tables under all graphs with 3+ categories  
Colors  Graphs colors should be part of the OCA Palette 
Alt Text  Alt text3 is meant to convey the “why” of the image as it relates to the 

content of a document or webpage. It is read aloud to users by screen 
reader software, and it is indexed by search engines. It should be added 
to all graphs and be included in the caption. The accessibility of the 
document should be checked prior to publishing using Word’s 
Accessibility Checker found in the review tab. For more information on 
how to access the Accessibility Checker, click here. For more information 
on how to add alt text, click here.  

 

 
3 To learn more about alt text see: https://accessibility.huit.harvard.edu/describe-content-
images#:~:text=Alternative%20(Alt)%20Text%20is%20meant,example%20of%20a%20missing%20image.  
 

https://support.microsoft.com/en-us/office/insert-a-page-break-in-word-eb0e569c-8e3f-4db4-9b13-7bfe1cabdbd7
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#:%7E:text=In%20Word%2C%20Excel%2C%20and%20PowerPoint,to%20add%20it%20there%20manually.
https://support.microsoft.com/en-us/office/add-alternative-text-to-a-shape-picture-chart-smartart-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669
https://accessibility.huit.harvard.edu/describe-content-images#:%7E:text=Alternative%20(Alt)%20Text%20is%20meant,example%20of%20a%20missing%20image
https://accessibility.huit.harvard.edu/describe-content-images#:%7E:text=Alternative%20(Alt)%20Text%20is%20meant,example%20of%20a%20missing%20image
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Tables   
 
The following table outlines the formatting guidelines for all tables included in the document.  

Table 6: Table Formatting Guidelines    
Component  Rule  
Title   Font size 12, bolded, white, dark blue (Turquoise, Accent 1, Hex #006A8E 

background).  
Table Header The table header row option should always be checked when creating 

tables in order to make them more accessible. To set a header row, select 
the table, then select the Design Tab in Table Tools, on the left-hand side 
check the “Header Row” box.  

Rows   Alternating light blue (Aqua, Accent 2 80% Lighter, Hex # DBEEF4) and 
white starting with light blue  

Alignment     Left  
Alt Text  Alt text should be added to all tables. The accessibility of the document 

should be checked prior to publishing using Word’s Accessibility Checker 
found in the review tab. For more information on how to access the 
Accessibility Checker, click here. For more information on how to add alt 
text, click here.  

Text Box   

 
 

Text Box Formatting Guidelines  

The following formatting rules should be applied to all text boxes: 

Title: Bolded, centered  

Font: Calibri, size 12 

Outline: 1.50 width; Aqua, Accent 5, Darker 25%, Hex # 31849B  

Background: Aqua, Accent 2 80% Lighter, Hex # DBEEF4 

Shape Style: No shadowing should be added to the text box   

Alt Text: Alt text should be added to all text boxes. The accessibility of the document should 
be checked prior to publishing using Word’s Accessibility Checker found in the review tab. 
For more information on how to access the Accessibility Checker, click here. For more 
information on how to add alt text, click here.  

https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#:%7E:text=In%20Word%2C%20Excel%2C%20and%20PowerPoint,to%20add%20it%20there%20manually.
https://support.microsoft.com/en-us/office/add-alternative-text-to-a-shape-picture-chart-smartart-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#:%7E:text=In%20Word%2C%20Excel%2C%20and%20PowerPoint,to%20add%20it%20there%20manually.
https://support.microsoft.com/en-us/office/add-alternative-text-to-a-shape-picture-chart-smartart-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669
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Text Wrapping    
 
All text wrapping should be set to the “in line with text,” in order to create a more accessible 
document. For more on text wrapping, please click here.  

Graphics 
 
The following table outlines the formatting guidelines for all graphics included in the document.  

Table 7: Graphics Formatting Guidelines  
Component  Rule  
Borders  Graphics should not have borders outlining them   
Caption Font size 10, include source (if applicable), figure captions should not be 

italicized. 
Colors  Any smart art used to create graphics color should use the OCA Palette 
Alt Text  Alt text should be added to all graphics and be included in the captain. 

The accessibility of the document should be checked prior to publishing 
using Word’s Accessibility Checker found in the review tab. For more 
information on how to access the Accessibility Checker, click here.  For 
more information on how to add alt text, click here.  

 

Example:  

 

 

 

 

 

 

 

 

Citations and Footnotes   

The OCA uses the American Psychological Association (APA) citation and format style.4 To learn 
more about APA and its general guidelines click here.  When citing a resource, the following 
guidelines should be followed: 

 
4 Purdue University. (2020). APA Style Introduction. 
https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_style_introduction.html  

JJPAD Board

Data 
Subcommittee

Community Based 
Interventions 

Subcommittee

Childhood Trauma 
Task Force

Figure X: JJPAD and CTTF Structure 

https://support.microsoft.com/en-us/office/wrap-text-around-a-picture-in-word-bdbbe1fe-c089-4b5c-b85c-43997da64a12#:%7E:text=Go%20to%20Picture%20Format%20or%20Shape%20Format%20and%20select%20Arrange,and%20Bottom%2C%20and%20Behind%20Text.
https://support.microsoft.com/en-us/office/improve-accessibility-with-the-accessibility-checker-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f#:%7E:text=In%20Word%2C%20Excel%2C%20and%20PowerPoint,to%20add%20it%20there%20manually.
https://support.microsoft.com/en-us/office/add-alternative-text-to-a-shape-picture-chart-smartart-graphic-or-other-object-44989b2a-903c-4d9a-b742-6a75b451c669
https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_style_introduction.html
https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_style_introduction.html
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• Citations should appear in the footnotes at the bottom of the page. To learn more about 
footnotes, click here.  

• Citations should be font size 9  
• Citations should include a Digital Object Identifier (DOI) or link to the reference material. 

A DOI is a unique and never-changing string assigned to online journal articles, books, 
and other works. DOIs make it easier to retrieve works, which is why APA recommends 
including them in citations. 

o Example of citation with DOI: Briggs-Gowan, M. J., Ford, J. D., Fraleigh, L., 
McCarthy, K., & Carter, A. S. (2010). Prevalence of exposure to potentially 
traumatic events in a healthy birth cohort of very young children in the 
northeastern United States. Journal of Traumatic Stress, 23(6), 725–733. 
https://doi.org/10.1002/jts.20593 

o Example of citation with link to reference material: The National Child Traumatic 
Stress Network. (n.d). Screening and Assessment. The National Child Traumatic 
Stress Network. https://www.nctsn.org/treatments-and-practices/screening-
and-assessment  

• When citing data from a frequently updated source, such as a Tableau Public page, the 
citation must include “Accessed [date].” However, non-data citations, such as 
information from a website, do not need to include “Accessed [date].”  

• When referencing a specific resources/report in the narrative of the report, the resource 
material should be linked directly in the text and in the footnote/citation as directed.  

• Citations of a Massachusetts state agency report (including OCA reports) should be 
formatted in the footnote so that the name of the agency are hyperlinked. 

o Example: Massachusetts Department of Children and Families. (2021). FY21 
Annual Report. https://www.mass.gov/doc/dcf-annual-reportfy2021/download  

• If multiple consecutive sentences are using information from the same source, cite the 
source after the first sentence and not subsequent ones. 

For legal citations, the OCA follows the guidelines put forth in The Bluebook, the style 
manual for citing to legal documents within the United States.  To learn more about The 
Bluebook, including how to cite cases, statues, and other resources, click here or here. 

 

 

 

 

 
 

https://support.microsoft.com/en-us/office/add-footnotes-and-endnotes-bff71b0c-3ec5-4c37-abc1-7c8e7d6f2d78#:%7E:text=Add%20a%20footnote,Type%20the%20footnote%20text.
https://doi.org/10.1002/jts.20593
https://www.nctsn.org/treatments-and-practices/screening-and-assessment
https://www.nctsn.org/treatments-and-practices/screening-and-assessment
https://www.mass.gov/orgs/massachusetts-department-of-children-families
https://www.mass.gov/doc/dcf-annual-reportfy2021/download
https://guides.ll.georgetown.edu/bluebook
https://pennstatelaw.psu.edu/sites/default/files/documents/pdfs/Bluebook_Guide_Practitioners_21st_ed.pdf
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Appendix A: Example  
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